
University of Anbar 

College of Computer Science 

and Information Technology 

Computer Network Systems Department 
 

 

 

 

 

Lecture Eight 

Third Stage 

 

First Course 2021 - 2022 
 

 

 

 

 

 

Seddiq Qais Abd Al-Rahman 

MSc Computer Science 

co.sedeikaldossary@uoanbar.edu.iq 

 

 

  



Lecture 8: Windows Form, Button, Label, TextBox 

3rd Stage, 1st Course, 2020-2021 

Visual Programming I 

Seddiq Abd Al-Rahman 

 

 2 

Visual Programming 

 

Windows Form 

The Windows Form is a vital component in the development of any Windows-based 

application. Forms essentially provide the windows that make up a Windows application. In 

fact, the terms window and form are often used interchangeably. Forms allow the C# 

developer to create windows and layout controls (such as buttons, labels etc) in those forms 

to provide the application's user interface.  

 

Changing the Form Name 

All GUI objects in a C# application need a name so that they can be referenced in the C# 

code. When a new object is added to an application in Visual Studio it is assigned a default 

name which usually consists of the object type and a number. For example the first form 

object in an application is named Form1, the second Form2, and so on. To change the name 

of a Form to something more meaningful, simply click in any area of the Form in Visual 

Studio and change the (Name) value in the Properties panel. 

 

Changing the Form Title 

Each form in Visual Studio represents an application window in the finished C# based 

application. The text displayed in the title bar for each window should be changed to display 

something meaningful. This should either be the name of application, or a description of the 

form's function (for example Order Entry or Save File). 

The value of the text to be displayed in the window title is defined by the selected 

form's Text property. To change the title of the form, therefore, select the Text value in 

the Properties panel (located by default in the bottom right hand corner of the Visual Studio 

main window) and change it to a new value (for example, 'C# Form Example'):  

 

https://www.techotopia.com/index.php/File:C_sharp_form_title.jpg
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Changing the Form Background Color 

The background of any form may be changed either by specifying a new color, or by using 

a background image. The background color is controlled by the BackColor property of the 

form. By default this property is set to Control. This specifies that the form should use a 

system defined default color. This color varies between different Windows versions, and 

changes when the user changes the overall color scheme of their Windows system. 

To change the background color, select the form in Visual Studio and locate 

the BackColor property in the Properties panel. There are a number of ways to specify a 

color. 

• Color by name - Simply type in a color name into the BackColor value field (for 

example Red, Yellow, Cyan etc). 

• Color by RGB value - Colors may be specified by entering the hexadecimal RGB 

values (for example #FFFFFF for white, #000000 for while and so on). RGB values 

may also be specified using decimal values (for example 255,255,255 for white, 0,0,0 

for black etc). 

• Color from existing palette - Clicking on the down arrow in the BackColor value 

field will display a drop down menu. Lists are available for web safe colors, custom 

colors and system colors. 

Once you have selected a new color the background color of your form will change to reflect 

the new setting. 

 

Changing The Form Background Image 

In addition to changing the background color of a form, it is also possible to specify a 

background image. This is specified using the form's BackgroundImage property in 

the Properties panel. When the BackgroundImage property is selected in the Property panel 

a button containing the label '...' appears. Click on this button to display the  Select 

Resource window: 

 

https://www.techotopia.com/index.php/File:Visual_studio_select_resource.jpg
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Click on the Local Resource option button and click on Import to browse for an image. If 

you don't have any images of your own readily available try looking in for the Sample 

Pictures folder in My Documents. 

Once selected, the image will be applied to the form background and any controls added 

will appear on top of the image. The following figure shows a form with a background image 

and a Button control: 

 

If the image used for the background is smaller than the form size, windows will use multiple 

copies of the image in a tile arrangement to ensure the entire available area is filled.  

 

Configuring the Minimize, Maximize and Close Buttons 

Each window in a Windows application has, by default, Minimize, Maximize and Close 

buttons in the top left hand corner of the title bar. In addition, clicking on the icon on the 

right hand side of the title bar drops down a control box containing the same options, plus 

options to resize the window. 

These options make it easy for the user to perform tasks such as minimizing or maximizing 

a form. If, however, you do not want these controls to be available for a particular form they 

can be disabled from the Properties panel for the form in question. To disable the Maximize 

button set the MaximizeBox property to False. Similarly, disable the Minimize button by 

setting the MinimizeBox property to False. In each case the button will still be visible, but 

will be disabled so the user cannot click on it. 

To remove all controls, including the Control Box and the Minimize, Maximize and Close 

buttons set the ControlBox property to false. When set, the only content in the form's toolbar 

will be the form title. 

 

Setting Minimum and Maximum Form Sizes 

The minimum and maximum sizes of a form can be specified. These limitations are 

controlled via the MinimumSize and MaximumSize properties respectively. Once set, 

https://www.techotopia.com/index.php/File:C_sharp_form_background_image.jpg
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assuming the form is sizable, the user will not be able to resize the form beyond the size  

boundaries you have defined using these properties. 

Specifying the Position of a Form on the Display 

The initial position of a form when it is first displayed in an application is controlled by the 

form's StartPosition property in conjunction with the Location property. The StartPosition 

property can be set to one of a number of different values: 

• Manual - Sets the initial position of the form to the X and Y coordinates specified by 

the Location property. 

• CenterScreen - Specifies that the form should be positioned in the center of the display. 

• WindowsDefaultLocation - This is the default setting for this property and dictates that 

the form be positioned in the default Windows location for new windows (typically 

near the top left hand corner of the screen). 

• CenterParent - If the form is a child of another form, this value specifies that the form 

should be positioned within the center of the parent form. 

Changing the Form Border 

By default a form can be resized by the user. Visual Studio allows both the behavior, and the 

appearance of the border to be controlled by manipulating the FormBorderStyle property. The 

border may be configured to allow, or disallow resizing of the form, with a variety of border 

styles (such as 3D). 

To change the border, select the FormBorderStyle in the Properties panel of the form you wish 

to modify. Click on the down arrow in the value field to drop down a menu of items and select 

the setting of your choice. Feel free to experiment with the different settings, using the F5 key 

to build and run your application to try out each setting. 

Stopping a Form from Appearing the Windows Taskbar 

By default every form in an application is shown in the Windows desktop taskbar when it is 

created. Whilst this is acceptable for a small application consisting of one or two forms, it is 

unlikely that you would want every single form to appear in the taskbar. 

To prevent a form from appearing the taskbar simply set the ShowInTaskbar property to False. 

Creating a Transparent Form 

The Opacity property can be used to control the degree of transparency of a form of control. 

The lower the opacity percentage, the more transparent the form or control. To make a form 

transparent, select the form and change the Opacity percentage to 70% (if you select a 

percentage that is too low the form will be invisible when the application is run). Press F5 to 

build and run the application. The form will be partially transparent in that you can still see the 

form and its controls, but you can also see what is on the desktop behind the form. 
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Hello World Program 

Create a project 

First, you'll create a C# application project. The project type comes with all the template files 

you'll need, before you've even added anything. 

• Open Visual Studio. 

• On the start window, choose Create a new project. 

• On the Create a new project window, choose the Windows Forms App (.NET 

Framework) template for C#. 

(If you prefer, you can refine your search to quickly get to the template you want. For example, 

enter or type Windows Forms App in the search box. Next, choose C# from the Language list, 

and then choose Windows from the Platform list.) 

Create the application 

After you select your C# project template and name your file, Visual Studio opens a form for 

you. A form is a Windows user interface. We'll create a "Hello World" application by adding 

controls to the form, and then we'll run the app. 

• Add a button to the form 

Choose Toolbox to open the Toolbox fly-out window. 

 

(If you don't see the Toolbox fly-out option, you can open it from the menu bar. To do 

so, View > Toolbox. Or, press Ctrl+Alt+X.) 

• Choose the Pin icon to dock the Toolbox window. 
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• Choose the Button control and then drag it onto the form. 

 

• In the Properties window, locate Text, change the name from Button1 to Click this, 

and then press Enter. 

 

• (If you don't see the Properties window, you can open it from the menu bar. To do so, 

choose View > Properties Window. Or, press F4.) 

• In the Design section of the Properties window, change the name 

from Button1 to btnClickThis, and then press Enter. 
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• Add a label to the form 

Now that we've added a button control to create an action, let's add a label control to send text 

to. 

• Select the Label control from the Toolbox window, and then drag it onto the form and 

drop it beneath the Click this button. 

• In either the Design section or the (DataBindings) section of the Properties window, 

change the name of Label1 to lblHelloWorld, and then press Enter. 

• Add code to the form 

• In the Form1.cs [Design] window, double-click the Click this button to open 

the Form1.cs window. 

• (Alternatively, you can expand Form1.cs in Solution Explorer, and then 

choose Form1.) 

• In the Form1.cs window, after the private void line, type or enter lblHelloWorld.Text 

= "Hello World!"; as shown in the following screenshot: 

 

• Run the application 

• Choose the Start button to run the application. 



Lecture 8: Windows Form, Button, Label, TextBox 

3rd Stage, 1st Course, 2020-2021 

Visual Programming I 

Seddiq Abd Al-Rahman 

 

 9 

 

• Several things will happen. In the Visual Studio IDE, the Diagnostics Tools window 

will open, and an Output window will open, too. But outside of the IDE, 

a Form1 dialog box appears. It will include your Click this button and text that 

says Label1. 

• Choose the Click this button in the Form1 dialog box. Notice that the Label1 text 

changes to Hello World!. 

 

• Close the Form1 dialog box to stop running the app. 

 

Button in C# 

A Button is an essential part of an application, or software, or webpage. It allows the user to 

interact with the application or software. For example, if a user wants to exit from the current 

application so, he/she click the exit button which closes the application. It can be used to 

perform many actions like to submit, upload, download, etc. according to the requirement of 

your program. It can be available with different shape, size, color, etc. and you can reuse them 

in different applications. In .NET Framework, Button class is used to represent windows button 

control and it is inherited from ButtonBase class. It is defined under 

System.Windows.Forms namespace. 

In C# you can create a button on the windows form by using two different ways: 

1. Design-Time: It is the easiest method to create a button. Use the below steps: 

• Step 1: Create a windows form as shown in the below image: 

Visual Studio -> File -> New -> Project -> WindowsFormApp 
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• Step 2: Drag the Button control from the ToolBox and drop it on the windows form. 

You are allowed to place a Button control anywhere on the windows form according to 

your need. 

 
• Step 3: After drag and drop you will go to the properties of the Button control to set the 

properties of the Button. 

 
2. Run-Time: It is a little bit trickier than the above method. In this method, you can create 

your own Button using the Button class. 

• Step 1: Create a button using the Button() constructor is provided by the Button class. 

• // Creating Button using Button class 
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• Button MyButton = new Button(); 

• Step 2: After creating Button, set the properties of the Button provided by the Button 

class. 

• // Set the location of the button 

• Mybutton.Location = new Point(225, 198); 

• // Set text inside the button 

• Mybutton.Text = "Submit"; 

• // Set the AutoSize property of the button 

•  Mybutton.AutoSize = true; 

• // Set the background color of the button 

• Mybutton.BackColor = Color.LightBlue; 

• // Set the padding of the button 

• Mybutton.Padding = new Padding(6); 

• // Set font of the text present in the button 

• Mybutton.Font = new Font("French Script MT", 18); 

• Step 3: And last add this button control to form using Add() method. 

• // Add this Button to form 

• this.Controls.Add(Mybutton); 

Example: 

filter_none 

brightness_4 

using System;  

using System.Collections.Generic;  

using System.ComponentModel;  

using System.Data;  

using System.Drawing;  

using System.Linq;  

using System.Text;  

using System.Threading.Tasks;  

using System.Windows.Forms;  
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  namespace WindowsFormsApp8 {  

  public partial class Form1 : Form {  

      public Form1()  

    {  

        InitializeComponent();  

    }  

      private void Form1_Load(object sender, EventArgs e)  

    {  

          // Creating and setting the properties of label  

        Label l = new Label();  

        l.AutoSize = true;  

        l.Text = "Do you want to submit this project?";  

        l.Location = new Point(222, 145);  

        l.Font = new Font("French Script MT", 18);  

        // Adding this label to form  

        this.Controls.Add(l);  

          // Creating and setting the properties of Button  

        Button Mybutton = new Button();  

        Mybutton.Location = new Point(225, 198);  

        Mybutton.Text = "Submit";  

        Mybutton.AutoSize = true;  

        Mybutton.BackColor = Color.LightBlue;  

        Mybutton.Padding = new Padding(6);  

        Mybutton.Font = new Font("French Script MT", 18);  

          // Adding this button to form  

        this.Controls.Add(Mybutton);  

          // Creating and setting the properties of Button  

        Button Mybutton1 = new Button();  
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        Mybutton1.Location = new Point(360, 198);  

        Mybutton1.Text = "Cancel";  

        Mybutton1.AutoSize = true;  

        Mybutton1.BackColor = Color.LightPink;  

        Mybutton1.Padding = new Padding(6);  

        Mybutton1.Font = new Font("French Script MT", 18);  

          // Adding this button to form  

        this.Controls.Add(Mybutton1);  

    }  

}  

}  

Output: 

 

Important Properties of Button 

PROPERTY DESCRIPTION 

BackColor Using BackColor property you can set the background color of the button. 

BackgroundImage Using BackgroundImage poperty you can set the background image on the 

button. 

AutoEllipsis Using AutoEllipsis property you can set a value which shows that whether 

the ellipsis character (…) appears at the right edge of the control which 

denotes that the button text extends beyond the specified length of the 

button. 

AutoSize Using AutoSize property you can set a value which shows whether the 

button resizes based on its contents. 

Enabled Using Enabled property you can set a value which shows whether the button 

can respond to user interaction. 
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Events Using Events property you can get the list of the event handlers that are 

applied on the given button. 

Font Using Font property you can set the font of the button. 

FontHeight Using FontHeight property you can set the height of the font. 

ForeColor Using ForeColor property you can set the foreground color of the button. 

Height Using Height property you can set the height of the button. 

Image Using Image property you can set the image on the button. 

Margin Using Margin property you can set the margin between controls. 

Name Using Name property you can set the name of the button. 

Padding Using Padding property you can set the padding within the button. 

Visible Using Visible property you can set a value which shows whether the button 

and all its child buttons are displayed. 

 

Label in C# 

In Windows Forms, Label control is used to display text on the form and it does not take part 

in user input or in mouse or keyboard events. The Label is a class and it is defined under 

System.Windows.Forms namespace. In windows form, you can create Label in two different 

ways: 

1. Design-Time: It is the easiest method to create a Label control using the following steps: 

• Step 1: Create a windows form as shown in the below image: 

Visual Studio -> File -> New -> Project -> WindowsFormApp 

 
• Step 2: Drag the Label control from the ToolBox and drop it on the windows form. You 

are allowed to place a Label control anywhere on the windows form according to your 

need. 
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• Step 3: After drag and drop you will go to the properties of the Label control to set the 

properties of the Label according to your need. 

 
 

Output: 

 
2. Run-Time: It is a little bit trickier than the above method. In this method, you can set create 

your own Label control using the Label class. Steps to create a dynamic label: 
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• Step 1: Create a label using the Label() constructor is provided by the Label class. 

• // Creating label using Label class 

• Label mylab = new Label(); 

• Step 2: After creating Label, set the properties of the Label provided by the Label class. 

• // Set the text in Label 

• mylab.Text = "GeeksforGeeks"; 

• // Set the location of the Label 

• mylab.Location = new Point(222, 90); 

• // Set the AutoSize property of the Label control 

• mylab.AutoSize = true; 

• // Set the font of the content present in the Label Control 

• mylab.Font = new Font("Calibri", 18); 

• // Set the foreground color of the Label control 

• mylab.ForeColor = Color.Green; 

• // Set the padding in the Label control 

•  mylab.Padding = new Padding(6); 

• Step 3: And last add this Label control to form using Add() method. 

• // Add this label to the form 

• this.Controls.Add(mylab); 

Example: 

filter_none 

brightness_4 

using System;  

using System.Collections.Generic;  

using System.ComponentModel;  

using System.Data;  

using System.Drawing;  

using System.Linq;  

using System.Text;  

using System.Threading.Tasks;  
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using System.Windows.Forms;  

  namespace WindowsFormsApp18 {  

  public partial class Form1 : Form {  

      public Form1()  

    {  

        InitializeComponent();  

    }  

      private void Form1_Load(object sender, EventArgs e)  

    {  

        // Creating and setting the label  

        Label mylab = new Label();  

        mylab.Text = "GeeksforGeeks";  

        mylab.Location = new Point(222, 90);  

        mylab.AutoSize = true;  

        mylab.Font = new Font("Calibri", 18);  

        mylab.ForeColor = Color.Green;  

        mylab.Padding = new Padding(6);  

        // Adding this control to the form  

        this.Controls.Add(mylab);  

    }  

}  

}  

Output: 
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Important Properties of the Label Control 

PROPERTY DESCRIPTION 

AutoSize This property is used to set a value indicating whether the Label control is 

automatically resized to display its entire contents. 

BackColor This property is used to set the background color for the Label control. 

BackgroundImage This property is used to set the background image for the Label control. 

BorderStyle This property is used to set the border style for the Label control. 

FlatStyle This property is used to set the flat style appearance of the label control. 

Font This property is used to set the font of the text displayed by the Label control. 

FontHeight This property is used to set the height of the font of the Label control. 

ForeColor This property is used to set the foreground color of the Label control. 

Height This property is used to set the height of the Label control. 

Image This property is used to set the image that is displayed on a Label. 

Location This property is used to set the coordinates of the upper-left corner of the 

Label control relative to the upper-left corner of its form. 

Name This property is used to set the name of the Label control. 

Padding This property is used to set padding within the Label control. 

Size This property is used to set the height and width of the Label control. 

Text This property is used to set the text associated with this Label control. 

TextAlign This property is used to set the alignment of text in the label. 

Visible This property is used to set a value indicating whether the control and all its 

child controls are displayed. 

Width This property is used to set the width of the Label control. 

 

 

 

 

TextBox Controls 

In Windows forms, TextBox plays an important role. With the help of TextBox, the user can 

enter data in the application, it can be of a single line or of multiple lines. The TextBox is a 

class and it is defined  

under System.Windows.Forms namespace. In C#, you can create a TextBox in two different 

ways: 

1. Design-Time: It is the simplest way to create a TextBox as shown in the following steps: 

• Step 1: Create a windows form. As shown in the below image: 

Visual Studio -> File -> New -> Project -> WindowsFormApp 
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• Step 2: Drag the TextBox control from the ToolBox and drop it on the windows form. 

You can place TextBox anywhere on the windows form according to your need. 

 

 
• Step 3: After drag and drop you will go to the properties of the TextBox control to modify 

the TextBox design according to your requirement. 
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2. Run-Time: It is a little bit trickier than the above method. In this method, you can create 

your own textbox using the TextBox class. 

 

• Step 1 : Create a textbox using the TextBox() constructor provided by the TextBox 

class. 

• // Creating textbox 

• TextBox Mytextbox = new TextBox(); 

• Step 2 : After creating TextBox, set the properties of the TextBox provided by the 

TextBox class. 

• // Set location of the textbox 

• Mytextbox.Location = new Point(187, 51); 

• // Set background color of the textbox 

• Mytextbox.BackColor = Color.LightGray; 

• // Set the foreground color of the textbox 

• Mytextbox.ForeColor = Color.DarkOliveGreen; 

• // Set the size of the textbox 

• Mytextbox.AutoSize = true; 

• // Set the name of the textbox 

• Mytextbox.Name = "text_box1"; 

• Step 3 : And last add this textbox control to from using Add() method. 

• // Add this textbox to form 

• this.Controls.Add(Mytextbox); 
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Example: 

filter_none 

brightness_4 

using System;  

using System.Collections.Generic;  

using System.ComponentModel;  

using System.Data;  

using System.Drawing;  

using System.Linq;  

using System.Text;  

using System.Threading.Tasks;  

using System.Windows.Forms;  

namespace my {  

public partial class Form1 : Form {  

    public Form1()  

    {  

        InitializeComponent();  

    }  

    private void Form1_Load(object sender, EventArgs e)  

    {  

        // Creating and setting the properties of Lable1  

        Label Mylablel = new Label();  

        Mylablel.Location = new Point(96, 54);  

        Mylablel.Text = "Enter Name";  

        Mylablel.AutoSize = true;  

        Mylablel.BackColor = Color.LightGray;  

        // Add this label to form  

        this.Controls.Add(Mylablel);  

        // Creating and setting the properties of TextBox1  
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        TextBox Mytextbox = new TextBox();  

        Mytextbox.Location = new Point(187, 51);  

        Mytextbox.BackColor = Color.LightGray;  

        Mytextbox.ForeColor = Color.DarkOliveGreen;  

        Mytextbox.AutoSize = true;  

        Mytextbox.Name = "text_box1";  

        // Add this textbox to form  

        this.Controls.Add(Mytextbox);  

    }  

}  

}  

Output: 

 

Important properties of TextBox 

PROPERTY DESCRIPTION 

AcceptsReturn This property is used to set a value which shows whether pressing 

ENTER in a multiline TextBox control creates a new line of text in the 

control or activates the default button for the given form. 

AutoSize This property is used to adjust the size of the TextBox according to the 

content. 

BackColor This property is used to set the background color of the TextBox. 

BorderStyle This property is used to adjust the border type of the textbox. 

CharacterCasing This property is used to check whether the TextBox control modifies 

the case of characters as they are typed. 

Events This property is used to provide a list of event handlers that are 

attached to this Component. 

Font This property is used to adjust the font of the text displayed by the 

textbox control. 
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ForeColor This property is used to adjust the foreground color of the textbox 

control. 

Location This property is used to adjust the coordinates of the upper-left corner 

of the textbox control relative to the upper-left corner of its form. 

Margin This property is used to set the margin between two textbox controls. 

MaxLength This property is used to set the maximum number of characters the 

user can type or paste into the text box control. 

Multiline This property is used to set a value which shows whether this is a 

multiline TextBox control. 

Name This property is used to provide a name to the TextBox control. 

PasswordChar This property is used to set the character used to mask characters of a 

password in a single-line TextBox control. 

ScrollBars This property is used to set which scroll bars should appear in a 

multiline TextBox control. 

Text This property is used to set the text associated with this control. 

TextAlign This property is used to adjust the alignment of the text in the TextBox 

control. 

TextLength This property is used to get the length of the text in the TextBox 

control. 

UseSystemPasswordChar This property is used to set a value which shows whether the text in 

the TextBox control should appear as the default password character. 

Visible This property is used to get or set a value which determine whether the 

control and all its child controls are displayed. 
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